
WigWam      
Welcome to the WigWam for CompuServe on-line Help.
WigWam for CompuServe is the first Windows-based Off-Line Reader of its kind.
WigWam lets you use all the facilities of CompuServe in your own time but not at your 
expense.
Due to the extensive use of graphics in this Help file you might find it more convenient to
maximise the Help window when reading topics containing graphics.
To find the help you need, start by selecting one of the items from the list below.
Using Help 
Menus 
Buttons 
Toolbox 



Menus  
For help on the options in the various menus select one of the menu titles listed below.
File 
Edit 
Options 
Forum 
Actions 
Housekeeping 
Help 



Buttons  
For help on functions provided by the button bar select one of the buttons pictured 
below.

 
Depending on your screen resolution you will be able to see between 12 and 20 buttons 
in the button bar.
The button bar shown above is the default and you can swap any of the buttons 
displayed using the Toolbox .
To change a button in the button bar for one of those in the toolbox you need to display 
the toolbox by selecting the Show Toolbox item from the Options menu, or if it is already 

in the button bar then select the  button.
From the toolbox, select the button you wish to put into the button bar, drag it until it is over
the button in the button bar that you wish to replace, and drop it.
Until you change the contents of the button bar again then the new buttons configuration 
becomes the default and will be displayed each time you start WigWam.



Glossary  
ADDCONC 
autojoin 
button bar 
CompuServe 
comment 
forum 
CONF.LIS 
download 
library list 
messagebase 
sysop 
user id 
OLR/Off-Line Reader 
POINT.BSC 
prune 
REPLY.BSC 
root 
thread 
section 
TP.INI 
unread 



File  
For help on one of the options in the File menu select one of the menu items listed below.
File - Ctrl+L 
Print - Ctrl+P 
View any file 
View Library List 
Download File 
Refresh Library List 
Exit - Ctrl+X  



File - Ctrl+L     
File is for saving one or more messages in the current section to a named file. This can 
be used to export message texts from the messagebase to other applications or 
computers. 

 
Current Message - saves the current message to a file. 
Current Thread - saves the thread of messages in which the currently highlighted 
message occurs to a file. 

From:     To:    

 - saves the messages in the range of the From message number to the To message 
number to a file. 
Select OK to display a common Save As dialog and specify the file to which the message(s) 
should be saved.

File can also be invoked by selecting  from the button bar or the toolbox.

To file just the current message you can use the  from the button bar or toolbox. 



Print - Ctrl+P     
Print is for when you want a printout of one or more messages in the current section. 

 
Current Message - prints the current message.
Current Thread - prints the thread of messages in which the currently highlighted 
message occurs. 

From:     To:    

 - prints the messages in the range of the From message number to the To message 
number.
Select OK to display a common Print dialog and specify the print options.

Print can also be invoked by selecting  from the button bar or the toolbox. 

To print just the current message you can use the  from the button bar or toolbox. 



View Library List     
View Library List is for browsing the library lists available for download from 
CompuServe. Additionally, any file highlighted in a list can be marked for download from 
CompuServe.

 
To browse a library list highlight the library name and select OK. Alternatively, double 
click the library name in the list.
A library list similar to -

 
is displayed.
Files are listed in the selected library according to criteria specified when the list was 
downloaded using the Refresh Library List option from the File menu, and in descending 
order of the date on which the file was added to the library. This means that the latest 
files appear at the top of the list.
Select Find to search for text in the library list.
The library listing is searched until the specified text is found or the end of the list is 
reached.



To download a file listed in the library, highlight the line containing the name of the file to
be downloaded and select Download to specify that the file is to be downloaded when 
you next connect to CompuServe.
Select Close to close the Library List Viewer window.

View Library List can also be invoked by selecting  from the button bar or the 
toolbox. 



Download File     
Download is the fast way of specifying a file to be downloaded from CompuServe but 
requires knowing the name of the file and which library the file is located in.

 
To download a file highlight the library name and select OK. Alternatively, double click 
the library name in the list.
At the prompt enter the name of the file to be downloaded and select OK.
The file is marked for download the next time you connect to CompuServe.

Download File can also be invoked by selecting  from the button bar or the toolbox. 



Refresh Library List     
Refresh Library List is for getting the first or an updated copy of a library listing.

 
To get a library list highlight the library name and select OK. Alternatively, double click 
the library name in the list.
When prompted, it is advisable to specify the maximum age in days of files to be 
included in the list you download. This is because some full library lists are very large 
and files added to the library before a certain date might, for various reasons, be of no 
interest to you, i.e. older versions of files nearer the top of the list. Downloading an 
unnecessarily large library list is expensive and time consuming. A blank entry places no 
age limitation on the files to be listed.
To further reduce the size of the library list to be downloaded you are then prompted to 
specify one or more keywords. Specifying keywords further qualifies the files appearing 
in the downloaded list. A blank entry causes all files in the library that fall within the age 
limit to appear in the downloaded list.
The library list will be downloaded the next time you connect to CompuServe.
For anyone new to CompuServe library lists it might be as well to specify a low value for 
the maximum age in days and no keywords until you understand the structure of a 
library list and how the use of the age of files and keywords affects the contents of the 
downloaded library listing.
Until you use the Refresh Library List option for the first time then the View Library List 
option in the File menu will be greyed out. 

Refresh Library List can also be invoked by selecting  from the button bar or the 
toolbox. 



Exit - Ctrl+X     
This is the way out of WigWam. 

Exit from WigWam can also be invoked by selecting  from the button bar or the 
toolbox. 



Edit     
For help on one of the options in the Edit menu select one of the menu items listed 
below. 
Copy - Ctrl+Ins 
Find - Ctrl+F 



Copy - Ctrl+Ins     
Copies text in the current message that has been highlighted to the Windows clipboard. 
From the clipboard the text can be transferred elsewhere in WigWam or to another 
application running in the Windows environment. 

Copy can also be invoked by selecting  from the button bar or the toolbox. 



Find - Ctrl+F     
Searches for text in the current section. 
The progress of the search operation is shown by a dialog box similar to -

 
You are advised if the string is not found. Otherwise the search terminates with the 
message containing the first occurrence of the string being displayed and the search text
in the message highlighted. 
You have to use this command again if you wish to find the next occurrence of the string.

Find can also be invoked by selecting  from the button bar or the toolbox. 



Options     
For help on one of the options in the Options menu select one of the menu items listed 
below. 
Show Button Bar 
Show Toolbox 
Font 
View Threads 
View Roots only 
View Chronologically 
Setup - Ctrl+E 



Show Button Bar     
Toggles the display of the button bar.
A tick against the menu item indicates that the option has been selected. 
There is no reason to display the button bar if you do not have or do not use a mouse to 
access the options offered by the button bar since all functions are duplicated in the 
various menus. 
For help on functions provided by the button bar select one of the buttons pictured 
below.

 



Font     
Displays the common Font dialog which allows you to choose the font to be used in the 
browse and message displays.



View Threads     
This is one of three modes in which you can browse through your messagebase. The 
other two modes are View Roots only and View Chronologically . Each mode is exclusive 
of the other two, i.e. you can only browse in any one mode at a time. 
A tick against the menu item indicates that the option has been selected. 
In the View Threads mode the browse display shows all the messages in your 
messagebase organised into what are known as threads. 

Thread mode can also be invoked by selecting  from the button bar or the toolbox. 



View Roots Only     
This is one of three modes in which you can browse through your messagebase. The 
other two modes are View Threads and View Chronologically . Each mode is exclusive of 
the other two, i.e. you can only browse in any one mode at a time. 
A tick against the menu item indicates that the option has been selected. 
In the View Roots only mode the browse display shows only the root messages in your 
messagebase. 

Root message mode can also be invoked by selecting  from the button bar or the 
toolbox. 



View Chronologically     
This is one of three modes in which you can browse through your messagebase. The 
other two modes are View Threads and View Roots only . Each mode is exclusive of the 
other two, i.e. you can only browse in any one mode at a time. 
A tick against the menu item indicates that the option has been selected. 
In the View Chronologically mode the browse display shows all the messages in your 
messagebase in ascending date and time order. 

Chronological mode can also be invoked by selecting  from the button bar or the 
toolbox. 



Setup - Ctrl+E     
Setup is for configuring WigWam to work with CompuServe and for you.

 
At various times you might want or need to remove messages you accumulate in your 
message database. The process of removing messages is referred to as pruning.

File pruned messages in  specifies an archive file for storing 
messages removed from the messagebase. A blank entry means that the messages are 
not saved and therefore irretrievably lost.

At the time of a prune operation, threads of messages which have had no further additions 
can be automatically deleted.
Keep inactive threads for  days specifies the minimum number of days a thread has 
to be inactive before the messages it contains are removed in a pruning operation.
The Sound checkbox when checked enables various sound effects.
The purpose of the Auto Join checkbox, if it is checked, is to automatically join the user 
locally to any new forums and/or sections for which there are messages in the latest 
scratchpad. 

If this box is not checked then you will have to use the Go option from the Forum menu.
The Line Gap checkbox when checked enables ... 
Help on the function of the Comms and Advanced buttons is available in separate topics 
within this Help file.
Selecting Cancel means that any changes made will not be saved to TP.INI, the WigWam 
initialisation file.
Selecting OK saves all changes to TP.INI, the WigWam initialisation file.



Forum     
For help on one of the options in the Forum menu select one of the menu items listed 
below. 
Go - Ctrl+J 
Next Forum - Ctrl+N 
Prev Forum - Ctrl+V 
View CIS Forums 
Join CIS Forum 
Refresh Forum List 
Resign 
Show 
Search 



Go - Ctrl+J     
To view messages in a specific section in your messagebase you need to join that 
section. 

 
Selecting a forum from the lefthand list displays the sections for the selected forum in 
the righthand list.
If you do not select a section from the righthand list before selecting OK, or if you double 
click on the forum name in the lefthand list then you will be joined to the first section in 
the selected forum.
If you do select a section from the righthand list and then select OK, you will be joined to 
the selected section within the selected forum.
Either way WigWam returns you to the main window with the first message in the chosen
section selected. 
Circumstances can arise where your messagebase contains forums and/or sections to 
which you are not joined locally, i.e. you cannot read the messages they contain even 
though messages for them are being downloaded from CompuServe. At some point you 
might wish to read these messages. This is the purpose of Register in the Join forum 
dialog box.
Selecting Register prompts you to enter a valid forum or section name.
Selecting OK from the prompt joins you to the specified forum or section in your 
messagebase. 
An alternative way of joining a section is to use the dropdown listbox which is part of the 
button bar. 

Joining a section can also be invoked by selecting  from the button bar or the 
toolbox. 



Next Forum - Ctrl+N     
Displays the first unread message in the next forum which has any unread messages. 
If there are no more unread messages then WigWam displays a blank main window. 

Next Forum can also be invoked by selecting  from the button bar or the toolbox. 



Prev Forum - Ctrl+V     
Displays the last forum visited before the one you are currently in.

Prev Forum can also be invoked by selecting  from the button bar or the toolbox. 



View CIS Forums     
View CIS Forums is for browsing the list of forums available on CompuServe. Additionally,
any forum highlighted in the list can be marked for joining.

 
Select Find to search for text in the forum list.
The forum listing is searched until the specified text is found or the end of the list is 
reached.
To join a forum on CompuServe scan the list for a forum you wish to join, highlight the 
line containing the name of the forum to be joined and select Join. At the prompt enter 
your name/handle. Type in whatever is appropriate and select OK.
Repeat this procedure for each forum to be joined.
Select Close to close the Forum List Viewer window.
N.B.  At this point it is prudent to point out that WigWam is not psychic.
It should be borne in mind that some forums on CompuServe have what amounts to 
registration procedures and not all these procedures are identical.
Therefore WigWam makes no attempt to handle these variable procedures. If you use 
WigWam to Join a new forum then most of the time you will be successful as WigWam is 
configured to handle the general case.
Where there is a variation then CompuServe and WigWam between them will tell you. In 
these instances the only option is to log on to CompuServe manually, GO to the forum in 
question, answer the registration questions, type in Join at the Forum prompt, answer 
any following questions and finally log off of CompuServe. Then you can use WigWam to 
Join the forum as per normal procedures.



Join CIS Forum  
Join CIS Forum is the fast way of specifying a forum on CompuServe to which you wish to 
be joined but requires knowing the name of the forum. 
At the prompt enter your name/handle. Type in whatever is appropriate.
You will be joined to the selected forum the next time you connect to CompuServe.
N.B.  At this point it is prudent to point out that WigWam is not psychic.
It should be borne in mind that some forums on CompuServe have what amounts to 
registration procedures and not all these procedures are identical.
Therefore WigWam makes no attempt to handle these variable procedures. If you use 
WigWam to Join a new forum then most of the time you will be successful as WigWam is 
configured to handle the general case.
Where there is a variation then CompuServe and WigWam between them will tell you. In 
these instances the only option is to log on to CompuServe manually, GO to the forum in 
question, answer the registration questions, type in Join at the Forum prompt, answer 
any following questions and finally log off of CompuServe. Then you can use WigWam to 
Join the forum as per normal procedures.

Join CIS Forum can also be invoked by selecting  from the button bar or the toolbox. 



Refresh Forum List     
Refresh Forum List is for getting the first or an updated copy of the list of forums 
available on CompuServe.A new forum list will be downloaded the next time you connect
to CompuServe.



Resign     
Resign is for when you no longer wish to be a member of a section or forum on 
CompuServe.
For help on one of the options in the submenu select one of the menu items listed below. 
Current Section 
Selected Forum 



Current Section  
Resigns you from the section you are currently joined to in your local messagebase.
When prompted regarding the downloading messages from CompuServe for the named 
section -

Selecting No resigns you from the section in your messagebase but messages for the 
section will still be downloaded from CompuServe and added to the messagebase. 
Selecting Yes resigns you from the named section in your messagebase and also on 
CompuServe. No further messages will be downloaded from CompuServe and added 
to your messagebase. You will be resigned from the section on CompuServe the next 
time you connect to CompuServe.

Resigning from the current section can also be invoked by selecting  from the 
button bar or the toolbox. 



Selected Forum  

 
Selecting a forum from the lefthand list displays the sections for the selected forum in 
the righthand list.
If you do not select a section from the righthand list before selecting OK, or if you double 
click on the forum name in the lefthand list then you will be resigned from the selected 
forum as a whole.
If you do select a section from the righthand list and then select OK, you will be only be 
resigned from the selected section within the selected forum.
When prompted regarding the downloading messages from CompuServe for the named 
section -

Selecting No resigns you from the forum or section in your messagebase but 
messages for the section will still be downloaded from CompuServe and added to the 
messagebase. 
Selecting Yes resigns you from the forum or section in your messagebase and also on 
CompuServe. No further messages will be downloaded from CompuServe and added 
to your messagebase. You will be resigned from the forum or section on CompuServe 
the next time you connect to CompuServe.



Show     
Show is for displaying information about your messagebase.
For help on one of the options in the submenu select one of the menu items listed below.
New Messages 
Joined Forums 
List of All Forums 



New Messages     
Displays a dialog box similar to - 

 
which lists all the sections with unread messages, together with the number of unread 
messages in each one. 
To copy all or part of the contents of the WigWam Status Viewer window, highlight the 
required text, and select Copy to transfer the highlighted text to the Windows Clipboard.
Select Close to close the WigWam Status Viewer window.



Joined Forums  
Displays a dialog box similar to - 

 
which displays a list of forums, the sections in each forum and for each section the 
number of unread messages and number of the last message read for each section.
To copy all or part of the contents of the WigWam Status Viewer window, highlight the 
required text, and select Copy to transfer the highlighted text to the Windows Clipboard.
Select Close to close the WigWam Status Viewer window.



List of All Forums  
Displays a dialog box similar to -

 
which shows all the forums to which you are currently joined to on CompuServe. 
To copy all or part of the contents of the WigWam Status Viewer window, highlight the 
required text, and select Copy to transfer the highlighted text to the Windows Clipboard.
Select Close to close the WigWam Status Viewer window.



Search  
Search is for finding text in your messagebase.
For help on one of the options in the submenu select one of the menu items listed below.
All Forums 
Selected Forums 



All Forums  
Searches all forums and sections in your messagebase.
At the prompt enter the text string to be searched for. 
The progress of the search operation is shown by a dialog box similar to -

 
which shows the progress of the search.
A dialog box similar to - 

 
is also displayed to list the messages containing the search string.
To copy all or part of the contents of the WigWam Status Viewer window, highlight the 
required text, and select Copy to transfer the highlighted text to the Windows Clipboard.
Select Close to close the WigWam Status Viewer window.

Search All Forums can also be invoked by selecting  from the button bar or the 
toolbox. 



Selected forums  
Searches only the specified forum or section in your messagebase.
At the prompt enter a text string to be searched for. 
Select a forum or section to be searched.

 
Selecting a forum from the lefthand list displays the sections for the selected forum in 
the righthand list.
If you do not select a section from the righthand list before selecting OK, or if you double 
click on the forum name in the lefthand list then the selected forum as a whole will be 
searched.
If you do select a section from the righthand list and then select OK, then only the 
selected section within the selected forum will be searched.
The progress of the search operation is shown by a dialog box similar to -

 
A dialog box similar to - 

 
is also displayed to list the messages containing the search string.
To copy all or part of the contents of the WigWam Status Viewer window highlight the 
required text and select Copy to transfer the highlighted text to the Windows Clipboard.
Select Close to close the WigWam Status Viewer window.



Actions     
For help on one of the options in the Actions menu select one of the menu items listed 
below. 
Connect to CIS 
Select Forums to Download 
Set CIS Options 
Comment - Ctrl+C 
Say - Ctrl+S 
Mail - Ctrl+A 
Address Book 
Script - Ctrl+B 
Original - Ctrl+I 
Next Unread - Ctrl+N 
Mark Message Read - <space> 
Mark Message Unread - Ctrl+U 
Fetch Full Message - > 
Withdraw Message - ~ 
Skip 
Mark All Read 



Connect to CIS  
There are three options available for using WigWam to connect to CompuServe.
For help on one of the options in the submenu select one of the menu items listed below.
Manual Connect 
Full Download - Ctrl+T 
Marked-only Download 



Manual Connect  
Logs you on to CompuServe using CISTERM and leaves you at the main CompuServe 
prompt to do whatever you wish.
When you exit from CompuServe you will be returned to CISTERM. Select Disconnect and
then Exit from the CISTERM Actions menu to return to the main WigWam window.

Manual Connect can also be invoked by selecting  from the button bar or the 
toolbox. 



Full Download - Ctrl+T  
Logs you on to CompuServe using CISTERM and will handle a fully automatic connection 
with CompuServe from start to finish until you are returned to the main WigWam window.

Full Download can also be invoked by selecting  from the button bar or the toolbox. 



Marked-only Download  
One of the message download options available when you use Select Forums to 
Download is to specify the downloading of message headers only.
You can then select messages for which you wish to download the full text.
Marked-only Download logs you on to CompuServe using CISTERM and will handle a fully 
automatic connection with CompuServe from start to finish until you are returned to the 
main WigWam window.
Unlike the Full Download only the text of those message headers previously marked 
using the Fetch Full Message option from the Actions menu is downloaded.

Marked-only Download can also be invoked by selecting  from the button bar or the 
toolbox. 



Select Forums to Download  
Use this option to select what you want to download from the forums you are joined to on
CompuServe.

 
When this option is first selected the Section box and Forum dropdown listbox are empty 
whereas the example graphic shown above is filled in with details. This is for the 
purposes of explanation in this Help file. The title bar indicates that the default file - 
CONFS.SEL - will be used unless otherwise directed.
Use the Forum dropdown listbox to access the list of forums to which you are joined to on
CompuServe. As each forum is selected then the Section box is filled similar to the 
example shown above.
For each of the sections listed you exclusively set the option to download either the full 
text of the messages in the section, the headers of the messages in the section or to 
download no messages at all.
You need only use this menu option whenever you wish to change details relating to the 
sections from which you download messages. The options set are acted upon each time 
you connect to CompuServe until they are changed.
Select Load to load the settings from a file. The title bar of the dialog box shows the 
name of the file loaded.
Select Save to save all settings to the current file as named in the title bar of the dialog 
box.
Select Save As to save all settings to a file specified by the user via the common Save As
dialog box. By using different named files, you can save different settings for different 
purposes, e.g. a weekday setting and a weekend setting.
Select Clear to reset the settings for all sections in the currently displayed Forum to 



'None'.
Select Clear All to reset the settings for all sections in all forums in the current settings 
file to 'None'.
Select Cancel to close the dialog box without saving any settings changes made.
Select OK to close the dialog box and updates the current settings file with all changes 
made.

Select Forums to Download can also be invoked by selecting  from the button bar or
the toolbox. 



Set CIS Options     
In between configuring WigWam and being able to use WigWam to work with 
CompuServe you need to upload your WigWam operating parameters to CompuServe. 
This is the purpose of the Set CIS Options.
You need only run Set CIS Options when you are setting up WigWam to work with 
CompuServe for the first time or if you ever want to reset your parameters.
At the prompt enter a name that will be used for private mail messages sent by you to 
other CompuServe users.
CISTERM is started using a special script file to initialise various settings on CompuServe.
Just sit back and watch as everything is automatically set up for you and at the end 
WigWam even logs you off of CompuServe and returns you to the main window from 
which you can now begin in earnest to use WigWam to make CompuServe easier and 
cheaper to use.



Comment - Ctrl+C     
Comment is for when you want to reply to a message you have read or are reading.

 
Comment to Current Message - reply to the current message.

Comment to Message Number     - reply to a specific message.
When checked, Include Original inserts the header and text of the message you are replying 
to at the start of your reply when the Message Editor is invoked.
Select OK to invoke the Message Editor .

A comment to the current message can also be invoked by selecting  from the button 
bar or the toolbox.



Say - Ctrl+S     
Say is for when you want to generate an original message using the Message Editor .

Say can also be invoked by selecting  from the button bar. 



Mail - Ctrl+A     
Mail is for sending private messages to one or more individuals.
The mail message options dialog box - 

 
provides you with the following options -

Select OK without selecting either of the check boxes to invoke the Message Editor 
with all fields blank so that you can send a mail message to an individual of your 
choosing.
Select OK with both check boxes selected to invoke the Message Editor with the To: 
field filled out with the name and user id of the individual who posted the current 
message. The header and content of the current message is also placed in the 
message area of the Editor. Before the Editor is invoked you are prompted to confirm 
that you wish to send mail to the named individual.
Select OK with just the Reply to Current Message box checked to invoke the Message 
Editor with the To: field filled out with the name and user id of the individual who 
posted the current message. Before the Editor is invoked you are prompted to 
confirm that you wish to send mail to the named individual.
Select OK with just the Include Current Message box checked to invoke the Message 
Editor with the To: field left blank for you to choose to whom you wish to send the 
mail message. The header and content of the current message is also placed in the 
message area of the Editor. Before the Editor is invoked you are prompted to confirm 
that you wish to send mail to the named individual.

Mail can also be invoked by selecting  from the button bar or the toolbox. 



Address Book     
The Address Book is for maintaining details of other users on CompuServe that you 
frequently correspond with.

 
To make use of the Address Book, open up the Message Editor - Mail or Message Editor - 
Say .    Make sure that the cursor is in the To: or CC: Message Editor field, and double click
on an address book entry. The 'Address' field of the entry will be pasted into the To: or 
CC: field of the Message Editor.
Alternatively you can just select an address book entry and use the To or CC button as 
appropriate to paste the 'Address' field of the entry into the relevant Message Editor 
field.
Please note:    If in the 'Name' field of the Address Book you put the name of a group, 
company, etc then you can create an address list (ie a list of several people against that 
name to whom you regularly send mail), by entering each person's address in the 
'Address' field, separated by semicolons.
Select Find to search for text in the Address Book. You can look for an entry by specifying 
full or partial text in the 'Name', 'Comment' or 'Address' fields of the Address Book.
The Address Book is searched until the entry containing the text is found or the end of 
the book is reached.
Select Edit to amend an existing entry in the Address Book that is currently highlighted.
Select Insert to add an entry to the Address Book containing the details of the originator 
of the currently highlighted message. The 'Comment' field can be used as you wish, no 
use is made of it by WigWam.
Select Delete to remove an existing entry in the Address Book that is currently 
highlighted.
Use the To and CC buttons as described above.
Selecting OK closes the Address Book without further ado if no changes have been made 
to it. If changes have been made then you are prompted to decide whether or not the 
Address Book is to be updated with any changes made before it is closed.



The Address Book can also be invoked by selecting  from the button bar or the 
toolbox. 



Script - Ctrl+B     
Script gives you access to commands , known by WigWam to be executable on 
CompuServe.

 
To execute one of the commands highlight it in the list and select OK. Alternatively 
double click on the script command in the list.
Most commands will generate one or more dialog boxes requesting parameters 
associated with the command. Respond as appropriate and the command(s) will be 
executed the next time you connect to CompuServe.

Script can also be invoked by selecting  from the button bar or the toolbox. 



Original - Ctrl+I     
Moves the message pointer in the browse display back to the message to which the 
current message is a comment. 
Obviously there will be no message pointer movement if the current message is a root 
message. 

Original can also be invoked by selecting  from the button bar or the toolbox. 



Next Unread - Ctrl+N     
Takes you to the next message in your messagebase which has not been read. 
If there are no more unread messages then WigWam displays a blank main window. 

Next Unread can also be invoked by selecting  from the button bar or the toolbox. 



Mark Message Read - <space>     
Mark Message Read does one of two things depending on whether the current message 
has already been read or is, as yet, unread. 
If the current message has already been read then the message pointer in the browse 
display is moved to the next unread message. 
If the current message is unread, i.e. there is a marker,  , to the left of the message 
number in the browse display, then this marker is removed to denote that the message is
deemed as read. The message pointer in the browse display is moved to the next unread
message. 

Mark Message Read can also be invoked by selecting  from the button bar or the 
toolbox. 



Mark Message Unread - Ctrl+U     
Mark Message Unread has no effect on the current message if it has not yet been read, 
i.e. there is a marker,  , to the left of the message number in the browse display. 

Otherwise it marks the current message with a marker,  , to the left of the message 
number in the browse display. 

Mark Message Unread can also be invoked by selecting  from the button bar or the 
toolbox. 



Fetch Full Message - >     

Fetch Full Message marks the currently highlighted message with a  to the left of the 
message number in the browse display.

The purpose of this marker is to indicate that the full text of this message is to be 
downloaded the next time you connect to CompuServe.
This option is only useful if you have previously downloaded the message headers.

Fetch Full Message can also be invoked by selecting  from the button bar or the 
toolbox. 



Withdraw Message - ~     
Withdraw Message deletes the message on CompuServe the next time you connect to 
CompuServe.
This function best serves as a means of correcting the case where, for whatever reason, 
copies of your messages are posted on CompuServe more than once. By withdrawing 
duplicates early enough you do others a favour in that their online time is reduced.

Withdraw Message can also be invoked by selecting  from the button bar or the 
toolbox. 



Skip     
Skip is for fast movement to specific points in your messagebase.

 
Current Thread - moves the message pointer to start of the next thread. 
To First - moves the message pointer to first message in the section. 
To Last - moves the message pointer to last message in the section. 

To:     - moves the message pointer to the user specified message number. 

Back:     - moves the message pointer back a user specified number of messages. 
You are prevented from going back further than the first message in a section. 
Select OK to invoke the skip. 



Mark All Read     
Mark All Read allows you to bypass having to read, one at a time, a large number of new 
messages of little immediate importance. 
You are prompted to confirm that you want to carry out this operation because once 
done it cannot be undone  . 



Housekeeping     
For help on one of the options in the Housekeeping menu select one of the menu items 
listed below. 
Delete - Ctrl+D 
Undelete 
Keep - Ctrl+K 
Unkeep 
Make Readonly 
Make Readwrite 
Forum Delete 
Prune 
Purge 
Build 
Reconstruct 



Delete - Ctrl+D     
Delete allows you to mark one or more messages in a section for deletion. Marked 
messages are only removed during a pruning operation. 

 
Current Message - marks the current message for deletion.
Current Thread - marks the thread of messages in which the currently highlighted 
message occurs for deletion.

From:     To:    

 - marks the messages in the range of the From message number to the To message 
number for deletion.
Messages marked for deletion have a  to the left of the message number in the browse 
display. 

Marking the current message for deletion can also be invoked by selecting  from the 
button bar or the toolbox, providing the message is not already marked. 



Undelete     
Undelete allows you to unmark one or more messages in a section previously marked for 
deletion .

 
Current Message - removes the delete marker against the current message.
Current Thread - removes the delete markers against the messages in the thread of 
messages in which the currently highlighted message occurs.

From:     To:    

 - removes the delete markers for the messages in the range of the From message 
number to the To message number.
Unmarking a message marked for deletion can also be invoked by selecting  from 
the button bar or the toolbox, providing the message is already marked. 



Keep - Ctrl+K     
Keep marks one or more messages in a section for indefinite keeping. Messages marked 
for keeping are not removed during a pruning operation.

 
Current Message - marks the current message for keeping.
Current Thread - marks the thread of messages in which the currently highlighted 
message for keeping.

From:     To:    

 - marks the messages in the range of the From message number to the To message 
number for keeping.
Messages marked for keeping have a  to the left of the message number in the browse 
display. 

Marking the current message for keeping can also be invoked by selecting  from the 
button bar or the toolbox, providing the message is not already marked. 



Unkeep     
Unkeep allows you to unmark one or more messages in a section previously marked for 
keeping .

 
Current Message - removes the keep marker against the current message.
Current Thread - removes the keep markers against the messages in the thread of 
messages in which the currently highlighted message occurs.

From:     To:    

 - removes the keep markers for the messages in the range of the From message 
number to the To message number.
Unmarking a message marked for keeping can also be invoked by selecting  from 
the button bar or the toolbox, providing the message is already marked. 



Make Readonly     
Designates forums or sections in your messagebase as "Read Only", i.e. no messages 
may be added to them.

 
Select a forum from the lefthand listbox. The righthand listbox will then display the 
sections for the selected forum.
If you do not select a section from the righthand listbox before selecting the OK button 
then all the sections in the forum are made "Read Only".
If you do select a section and then select the OK button then only that section within the 
forum is made "Read Only".



Make ReadWrite     
Designates forums or sections in your messagebase as "Read Write", i.e. messages may 
be added to them.

 
Select a forum from the lefthand listbox. The righthand listbox will then display the 
sections for the selected forum.
If you do not select a section from the righthand listbox before selecting the OK button 
then all the sections in the forum are made "Read Write".
If you do select a section and then select the OK button then only that section within the 
forum is made "Read Write".



Forum Delete     
Designate forums or sections you want to delete from your messagebase

 
Select a forum from the lefthand listbox. The righthand listbox will then display the 
sections for the selected forum.
If you do not select a section from the righthand listbox before selecting the OK button 
then all the sections in the forum are deleted.
If you do select a section and then select the OK button then only that section within the 
forum is deleted.You are prompted to confirm the deletion because once done it 
cannot be undone  .



Prune     
Prune is for maintenance of your messagebase.
Adding messages to your messagebase ad infinitum will use up space on your hard disk 
or other storage devices very quickly. You need a means of removing messages from the 
messagebase that can be selective and also allows removed messages to be archived for
later retrieval if necessary.
The Prune option allows you to do this.
For help on one of the options in submenu select one of the menu items listed below.
All files 
Selected files 
Prune is not an arbitrary operation. Messages deleted from your messagebase are 
deleted according to certain criteria. 
Firstly, Prune checks for the existence of a file called CONF.PRU .
If CONF.PRU does not exist you are prompted to confirm continuation of the Prune 
operation. Yes will cause WigWam to proceed based on the following criteria - 

Messages marked for deletion as designated with the  marker to the left of 
the message number in the browse display 

Threads of messages that have been inactive for more than the number of days specified by
you when configuring your WigWam setup using the Setup option from the Options menu. 

If CONF.PRU does exist then WigWam will proceed with the Prune based on the contents 
of CONF.PRU . 
The criteria specified in an existing CONF.PRU file take precedence over any other 
settings. 



All files     
All files in your messagebase will be pruned.
Because pruning is a major messagebase maintenance function you are prompted to 
confirm that you wish to prune all message files. 
The progress of the prune operation is shown by a dialog box similar to -

 
Depending on the size of the messagebase and the scope of the pruning operation this 
function can take some time to complete and might best be scheduled outside of peak 
usage of the PC on which it is run.



Selected files     
Designates forums or sections in your messagebase to be pruned.

 
Select a forum from the lefthand listbox. The righthand listbox will then display the 
sections for the selected forum.
If you do not select a section from the righthand listbox before selecting the OK button 
then all the sections in the forum are pruned.
If you do select a section and then select the OK button then only that section within the 
forum is pruned.
The progress of the prune operation is shown by a dialog box similar to -

 
Depending on the size of the messagebase and the scope of the pruning operation this 
function can take some time to complete and might best be scheduled outside of peak 
usage of the PC on which it is run.



Purge     
Prune will always leave at least one message in a forum or section section. The purpose 
of Purge is to remove said single message forums and sections in order to prevent the 
messagebase from becoming cluttered with dormant forums and sections. 
Purge prompts you to confirm the operation because once done Purge cannot be 
undone  . 



Build     
When upgrading WigWam from one version to the next it is advisable to re-initialise your 
messagebase pointers and indexes. 
It is also quite possible for the pointers and indexes of your messagebase to become 
corrupted. 
In both these cases you can use Build. 
Build prompts you to confirm that you wish to continue with the operation. 
The progress of the build operation is shown by a dialog box similar to -

 
Depending on the size of the messagebase this function can take some time to complete 
and might best be scheduled outside of peak usage of the PC on which it is run.



Reconstruct     
You have no control over the vagaries of the operation of CompuServe.
It is feasible that problems on CompuServe will result in it losing all the pointers to the 
forums and/or sections to which you are joined as well as which messages you have and 
have not read. 
Manually rescuing the situation can be an almost impossible task. 
WigWam can perform the task automatically using Reconstruct. 
Reconstruct creates a file, POINT.BSC, based on your local messagebase. This file can be 
uploaded to CompuServe as a script file for execution to restore the pointers. 
You are prompted to confirm whether you wish to reset pointers in all forums. 
Selecting Yes creates a POINT.BSC for all the pointers in all the forums and sections to 
which you are joined. 
Selecting No creates a POINT.BSC for those forums and sections to which you are joined 
and in which there are missing messages. 
The progress of the reconstruct operation is shown by a dialog box similar to -

 



Help     
For help on one of the options in the Help menu select one of the menu items listed 
below. 
Help 
About WigWam 



Using Help  
You can find information in Help by using the index or the Search feature. To return to the
Help Index after you read the instructions below, click the Back button or press the B key.
For complete instructions on how to use Help, press the F1 key while the Help window is 
active.
To use the Help Index  
 Do one of the following:
 Click an underlined topic.
 Press the TAB key until you highlight the topic you want, and then press the ENTER 

key.
To scroll in the Help window  

 Do one of the following:
 Press 

 and 
 .

 Use the scroll bars with the mouse.
To return to the previous topic  

 Click the Back button or press the B key.
To open the Search feature in Help  

 Click the Search button or press the S key.
To close the Help window  

 From Help's File menu, choose Exit (ALT, F, X).

Help can also be invoked by selecting  from the button bar or the toolbox. 



About WigWam     

 
WigWam - the  Windows OLR. 



Page Up     
Using this button causes the message display to scroll up by one page. The word page 
used in this context means however many lines of text fit into the area set aside for the 
display of the current message's text. 
This button is an alternative to using the mouse pointer to click on the vertical scroll bar 
track above the scroll box. 



Page Down     
Using this button causes the message display to scroll down by one page. The word page
used in this context means however many lines of text fit into the area set aside for the 
display of the current message's text. 
This button is an alternative to using the mouse pointer to click on the vertical scroll bar 
track below the scroll box. 



Comms     
Before WigWam can be used effectively to communicate with CompuServe you need to 
configure the parameters for its integrated comms module CISTERM .

 
This version of WigWam is configured to access CompuServe. 
Therefore the dialog box is oriented to providing WigWam with the necessary parameters
to connect you to CompuServe. 
The following is a quick checklist of the various Setting items - 

User ID is your CompuServe user id.
Password is your CompuServe password. Don't worry. The password is not displayed 
except as a sequence of asterisks and is internally encoded.
Phone is the number you normally dial to connect to CompuServe. Please read your 
CompuServe literature for the number most appropriate to you.
Down Dir is the name of the directory into which you wish files downloaded from 
CompuServe to be put. 
Script provides you with a list of scripts for use with WigWam. You should select the 
one most appropriate for the method you use to connect to CompuServe.
The Fetch Mail box should be checked if you wish to retrieve private mail messages at 
the same time as you download all other messages.
The Capture box should be checked if you wish WigWam to maintain a log file (called 
CISTERM.LOG) of everything that happens while you are connected to CompuServe. 
You should be able to set Speed to the speed of your modem or above if you have 



data compression in hardware, e.g. MNP or V42bis. 
Normal connection to CompuServe requires Parity be set to E and Word Size to 7 
however WigWam's internal comms module is set for Parity N and Word Size 8 and 
then changes the values when connected for maximum efficiency. 
Set Port to whichever serial port on your PC that you have connected your modem to.
Modem provides you with a list of the most commonly used modems. If you leave this 
item blank then WigWam will use the initialisation string you put in the Init box to 
initialise the modem before invoking CISTERM. If you select one of the modems listed 
then WigWam will provide an initialisation string appropriate to that modem.
Init String is a modem initialisation string appropriate for your modem. 
Dial String should be ATDT for tone phones or ATDP for pulse phones. 
Connect is the string you want the comms software to return when it gets a 
connection with CompuServe. CONNECT is good enough for most people. 
Wait is the number of seconds you want the internal comms module to wait to get a 
connection before a decision is made about what the state of play regarding 
connection is. 
Select OK and all changes will be saved to the WigWam initialisation file TP.INI, and 
then you will be returned to the Setup dialog box. 



Advanced  
The settings shown in the Advanced settings dialog need not be changed under normal 
circumstances. However the facility exists should you want to.

 
Script Path dictates the path where messages which you want to upload are put. You will 
not normally wish to alter this setting, which is really provided for LAN based systems. 
The File Locking checkbox is intended for use with the network version of WigWam and is
not applicable to this single user version. Please leave it unchecked.
The Single Script checkbox should be checked for this single user version of WigWam.
The Internal Comms should be checked if you intend using the integrated comms 
module, CISTERM, as supplied with WigWam. We recommend you use internal comms to 
provide seamless and efficient operation of WigWam.
Select OK and all changes will be saved to the WigWam initialisation file TP.INI, and then 
you will be returned to the Setup dialog box. 



Message Editor - Comment  
The Message Editor for replying to an existing message appears as follows - 

 
Menus  
For help on the items in the various menus select one of the menu titles listed below. 
File 
Edit 
Using the Message Editor - Comment     
If you opted to include the original message then the header and text of that message 
will appear in the message text area enclosed between ">>" and "<<" symbols.
To use this version of the message editor simply place the text of your message into the 
message text area. 
Select OK to write the message to REPLY.BSC for subsequent upload the next time you 
connect to CompuServe. 
Select Defer to place the message into temporary storage while you perform other 
WigWam functions. The next time you select one of the options which uses the Message 
Editor, i.e. Comment, Say or Mail , the message text will be retrieved into the message 
text area of the editor.
Select Address to call up the Address Book .
If you check the Don't Format checkbox then your message text will be sent as you have 
entered it and will not be formatted by CompuServe.
If you check the Private checkbox then you message will appear in the forum/section on 
CompuServe but it will only be seen by you the originator and the person to whom the 
message is directed. 



Message Editor - Say     
The Message Editor dialog box for creating an original message appears as follows - 

 
Menus     
For help on the items in the various menus select one of the menu titles listed below. 
File 
Edit 
Using the Message Editor - Say     
It is protocol to direct such a messsage -

To a specific individual - similar to a mail message but with the knowledge that others
can read and reply.
To All - which is as it implies.
To Sysop - the individual(s) responsible for the supervision of the forum.

So fill in the To: box as appropriate. You can of course use the Address button to call up 
the Address Book to fill in this field.
Switch to the Subject: box and enter the subject of the Say message.
Finally, switch to the main message area, type in the text of your Say message.
When finished select OK to put the message into the REPLY.BSC file which will be 
uploaded the next time you connect to CompuServe.
Select Defer to place the message into temporary storage while you perform other 
WigWam functions. The next time you select one of the options which uses the Message 
Editor, i.e. Comment , Say or Mail , the message text will be retrieved into the message 
text area of the editor. 
If you check the Don't Format checkbox then your message text will be sent as you have 
entered it and will not be formatted by CompuServe.
If you check the Private checkbox then you message will appear in the forum/section on 



CompuServe but it will only be seen by you the originator and the person to whom the 
message is directed. 



Message Editor - Mail     
The Message Editor dialog box for creating a mail message appears as follows - 

 
Menus     
For help on the items in the various menus select one of the menu titles listed below. 
File 
Edit 
Using the Message Editor - Mail     
If you opted to include the original message then the header and text of that message 
will appear in the message text area enclosed between ">>" and "<<" symbols.
In using this version of the message editor there are three other text entry boxes to be 
considered as well as the message text area used for the body of the message text. 
Firstly, there is the To: box. 
Depending on how the message editor was invoked then this box might already contain 
the email address of the person to whom you wish to send the message. If not then you 
most definitely need to enter this in order that the message gets to the recipient. 
Secondly, there is the CC: box. 
The purpose of this box is to allow you to enter the email address(es) of one or more 
other people whom you wish to send a copy of this message. It saves having to compose 
the same message several times over. 
The To: and CC: boxes can also be filled in using the Address button to call up the    
Address Book .
Thirdly, there is the Subject: box. 
This subject line is placed on a line of it's own at the head of the message so that when 



viewing the messages in the browse display it serves as a lead in to the content of the 
message which follows. 
There is no rule that says you need supply a subject. You can simply place the text of 
your message into the message text area.
Select OK to write the message to REPLY.BSC for upload the next time you connect to 
CompuServe. 
Select Defer to place the message into temporary storage while you perform other 
WigWam functions. The next time you select one of the options which uses the Message 
Editor, i.e. Comment , Say or Mail, the message text will be retrieved into the message 
text area of the editor. 
If you check the Don't Format checkbox then your message text will be sent as you have 
entered it and will not be formatted by CompuServe.
If you check the Private checkbox then you message will appear in the forum/section on 
CompuServe but it will only be seen by you the originator and the person to whom the 
message is directed. 



File     
For help on one of the options in the Message Editor File menu select one of the menu 
items listed below. 
Read Selection 
Write Selection 
Save As 



Read Selection     
Use this option to select a text file for inclusion as part of your message. 



Write Selection     
Use this option to save any text in your message which you have highlighted to a file. 



Save As     
Use this to save the whole text of your message to a file. 



Edit     
For help on one of the options in the Message Editor Edit menu select one of the menu 
items listed below. 
Undo - Alt+BkSp 
Cut - Shift+Del 
Copy - Ctrl+Ins 
Paste - Shift+Ins 
Clear - Del 
Select All 



Undo - Alt+BkSp     
Use this option to reverse the action taken by a preceding edit operation. 



Cut - Shift+Del     
This option copies highlighted text to the Windows clipboard and then deletes it from the 
message text. Cut text may be retrieved from the Windows clipboard using the Paste 
option from the Edit menu. 



Copy - Ctrl+Ins     
This option copies highlighted text to the Windows clipboard but does not delete it from 
the message text. Copied text may be retrieved from the Windows clipboard using the 
Paste option from the Edit menu. 



Paste - Shift+Ins     
This option inserts text previously placed on the Windows clipboard into the message 
text. 



Clear - Del     
This option deletes highlighted text message text but does not place it on the Windows 
clipboard for subsequent retrieval. 



Select All     
This option highlights all  the text in a message for use by another edit option. 



Script Commands  
The generic term for the file that WigWam submits to CompuServe when you connect is 
"script". All your message texts, requests for file downloads, etc are embedded in various
script commands. The following list is a means of directly supplying the script with 
instructions to perform the functions listed.
For help on the script commands select one of the items in the list below.
download file 
download library list 
join forum 
download forum list 
set high message number 
send binary mail 



join forum  
This function is more easily carried out using the    Join CIS Forum or View CIS Forums 
options from the Forum menu.



download library list  
This function is more easily carried out using the    View Library List option from the File 
menu. 



download file  
This function is more easily carried out using the Download file or View Library List 
options from the File menu.



download forum list  
This function is more easily carried out using the Refresh Forum List from the Forum 
menu.



set high message number  
The high message number is a pointer to the number of the last message that 
CompuServe reckons you have read in each of the forums to which you are joined.
You might have need to adjust this number to a value other than that held by 
CompuServe. One scenario is where you don't wish to download anexcessive number of 
unread messages.
This script command allows you to adjust the high message number for aspecific forum 
to which you are joined.
When prompted, specify the name of the forum you wish to set it for, and the the 
message number. An alternative to specifying a message number is to use "L" which sets
the high message number to the last message read as reckoned by CompuServe.
The high message number will be set for the selected forum the next time you connect 
to CompuServe.



CONF.PRU  
A messagebase can be pruned by using the Prune option from the Housekeeping menu.
Once the Prune operation is started, WigWam checks for the existence of the file 
CONF.PRU.
If the file exists it is used by WigWam to determine which messages are pruned from the 
messagebase and which are not. 
CONF.PRU contains one or more lines in the following format :-
<forum/section> <number>
This example might explain how it works :-
bproga 90      ;Prune after 90 days
msbasic 180 ;Prune after 180 days
winadv -1      ;Prune by delete only
ukforum -2    ;No Pruning to be done in that forum
The negative numbers specify the special conditions shown:-
-1 means that messages are only removed from that forum if they are explicitly deleted
-2 means that no messages will ever be removed even if they have been deleted

Any forums or sections not explicitly referred to in CONF.PRU are pruned according to the
default number of days specified by using the Setup option from the Options menu.



CISTERM  
CISTERM is the integrated comms utility used by WigWam to connect you to 
CompuServe.

 
CISTERM will, without further intervention on your part, connect you to CompuServe.
Except when using the Manual Connect all you need do is sit back and watch as CISTERM
handles the connection to CompuServe from logging in to logging off.
While CISTERM is connected to CompuServe you will see one or more instances of the 
following dialog box - 

 
showing you the progress of messages being downloaded from CompuServe.
When CISTERM finishes and returns you to the WigWam main window, any messages 
that have been downloaded need to be converted to a format readable by WigWam.
To do this WigWam uses a utility called Cnvrt for Windows -



 
Once the messages have been converted they need to be added to the messagebase 
and for this WigWam uses another utility -

 
which shows the progress of the converted messages being added to your messagebase.
On completion of ADDCONC you are returned to the WigWam main window.
If, during this session you have joined any new forums or sections then details are 
displayed in a dialog box - 



 
Where necessary you can scroll through the information listed and when finished, select 
the Close button to remove the dialog box from the screen.
If you highlight any text in the WigWam Status window you can copy this text to the 
Windows clipboard using the Copy button.
Menus  
For help on the items in the various menus select one of the menu titles listed below.
Action 
About 
Status 



Action  
For help on one of the options in the CISTERM Action menu select one of the menu items 
listed below.
Connect 
Disconnect 
Exit 



Connect  
Selecting the Connect option from the Action menu causes CISTERM to initiate a 
connection to CompuServe.



Disconnect  
Selecting the Disconnect option from the Action menu causes CISTERM to immediately 
drop the connection to CompuServe.



Exit  
This is the way out of CISTERM.



About  

 
CISTERM - the  Windows integrated comms utility.



OLR is a three letter acronym for Off-Line Reader. An Off-Line Reader is a piece of 
software that allows you to read and reply to messages posted in as well post new 
messages to an on-line conferencing system such as CompuServe without actually being 
connected to the system and thereby incurring the charges for being connected. In 
addition OLRs have many other facilities to make using an on-line conferencing system 
that much easier.



There are two kinds of message in your messagebase. There are root messages and 
there are comment messages. A thread is the description given to a sequence of 
messages beginning with a root message and having one or more comment messages 
attached to it. It can be likened to a conversation.



A root message is one which starts a conversation or thread.



A comment is a message which is part of a conversation or thread. As such it is a reply to
a root message or previous comment.



CompuServe - The world's largest personal information service.



Users of CompuServe are uniquely identified by a combination of their user id and their 
password.
My name is David Bird. I am the author of the Help file you are reading. My CompuServe 
user id is 100111,2171. If you have any comments or queries regarding the content or 
structure of the Help file then let me know.



A library list is a list of files available for download from CompuServe.
Most forums have at least one library list.



Download is the term which describes the retrieval of information from a remote source, 
e.g. CompuServe and usually to a local PC by means of a modem connected to the 
telephone system.



A section is one part of a forum and usually covers one aspect of the purpose of the 
forum. For example, a forum on PCs might have sections on hardware, software, 
peripherals, etc. By subsetting different aspects of a subject a more coherent discussion 
is maintained.



A term which describes a database of messages.



If you toggle the Show Button Bar option on the Options menu you will alternately display
and hide a row of picture buttons which can be accessed using the click of a mouse 
button.



The pruning of messages from your messagebase is a housekeeping function which 
removes messages from the messagebase according to specific criteria. 



Autojoin is a facility whereby a user is automatically joined to a forum or section.



A sysop is a CompuServe user who is responsible for the running of a forum or section on
CompuServe. Duties of a sysop can include ensuring that all messages are appropriate to
the section and the placing of files into a library list.



A forum is an area within CompuServe for discussion of a set of related topics. For 
example a forum on PCs might have sections on hardware, software, peripherals, etc.



An unread message is a message which has not yet been read or has been marked as 
unread and as such has a  marker to the left of the message number in the 
browse display.



CONF.LIS is the name of the file containing the list of forums available on CompuServe, 
generated when you select the Refresh Forum List option from the Forum menu.



POINT.BSC is the name of the script file generated by selecting the Reconstruct option 
from the Housekeeping menu. It contains pointers to forums and sections to which you 
are joined on CompuServe as well as the numbers of the last message downloaded from 
each section.



Upload is the term which describes the sending of information from a local source, 
usually a PC by means of a modem connected to the telephone system, to a remote Host
system, e.g. CompuServe.



TP.INI is the main configuration file for WigWam. It holds parameter values required by 
WigWam and obtained as a result of installing WigWam and from user responses supplied
by selecting the Setup option from the Options menu.



REPLY.BSC is the main script file created by WigWam as a result replying to messages 
downloaded from CompuServe, generating original messages and using the additional 
facilities of WigWam to generate script commands for upload to CompuServe.



ADDCONC is the utility supplied with WigWam which adds the messages in your 
scratchpad which you have downloaded from CompuServe into your messagebase.



Keyboard Shortcuts  
You can use a mouse to get around WigWam.
You can use the Alt key together with the key for the underlined letter shown in the menu
bar, e.g. Alt+F for File, and then the cursor keys to select an item in the dropdown menu 
and finally press <Enter> to invoke the option.
Or you can use one of the keyboard shortcuts listed below.
Ctrl+A 
Ctrl+B 
Ctrl+C 
Ctrl+D 
Ctrl+E 
Ctrl+F 
Ctrl+G 
Ctrl+H 
Ctrl+I 
Ctrl+J 
Ctrl+K 
Ctrl+L 
Ctrl+M 
Ctrl+N 
Ctrl+O 
Ctrl+P 
Ctrl+Q 
Ctrl+R 
Ctrl+S 
Ctrl+T 
Ctrl+U 
Ctrl+V 
Ctrl+W 
Ctrl+X 
Ctrl+Y 
Ctrl+Z 
F1 
Ctrl+Ins 
<space> 
> 
~ 
+ 
- 
Page Up 
Page Down 
Home 
End 
When using the Message Editor for Comment , Say , or Mail 
then the following keyboard shortcuts apply
Shift+Del 
Ctrl+Ins 
Shift+Ins 
Del 
Alt+BkSp 
When using CISTERM then the following keyboard shortcuts apply



Shift+PgUp 
Ctrl+Ins 
The following letter keys used on their own perform the functions attributed to them -
C - Comment.
S - Say.
D - Delete.
K - Keep.
To finish we have the four cursor arrow keys.
The up and down arrow keys move the highlight bar in the browse display up and down.
The right arrow key will -
if the highlight bar is not on the root message of a collapsed thread - move the highlight 
bar to the next message in the section.
if the highlight bar is on the root message of a collapsed thread - expand the thread to 
show all the messages in it.
The left arrow key will -
if the highlight bar is not on the root message in a thread - collapse the thread down to 
the root message.
if the highlight bar is on the root message in a thread - perform the Join local function.



Not Available  
Unused keyboard shortcut.



Page Up  
Keyboard shortcut for scrolling browse display up a page.



Page Down     
Keyboard shortcut for scrolling browse display down a page.



Home     
Keyboard shortcut for moving to first message in section.



End     
Keyboard shortcut for moving to last message in section.



To maximise a window using the mouse, click on the down arrow button at the top right 
of the window. To restore the window to it's normal size using the mouse, click on the 
double-headed arrow button at the top right of the window.
To maximise a window using the keyboard press Alt+Spacebar and select Maximize from 
the Control menu. To restore the window to it's normal size using the keyboard press 
Alt+Spacebar and select Restore from the Control menu.



View any file     
View any file is a general purpose file viewer similar to that shown below - 

 
It can be used to display the contents of any file selected via the common Open file 
dialog.
Select Find to search for text in the displayed file.
The file is searched until the specified text is found or the end of the file is reached.
Select Close to close the file Viewer window.



Toolbox  
For help on functions provided by the Toolbox select one of the buttons pictured below.

 
You can swap any of the buttons displayed using the Toolbox.
To change a button in the button bar for one of those in the toolbox you need to display 
the toolbox by selecting the Show Toolbox item from the Options menu, or if it is already 
in the button bar then select the  button.

From the toolbox, select the button you wish to put into the button bar, drag it until it is over
the button in the button bar that you wish to replace, and drop it.
Until you change the contents of the button bar again then the new buttons configuration 
becomes the default and will be displayed each time you start WigWam.



Show Toolbox     
Toggles the display of the Toolbox.
A tick against the menu item indicates that the option has been selected. 
There is no reason to display the Toolbox if you do not have or do not use a mouse to 
access the options offered by the Toolbox since all functions are duplicated in the various
menus. 
For help on functions provided by the Toolbox select one of the buttons pictured below.

 

Display of the Toolbox can also be invoked by selecting  from the button bar or 
the toolbox. 



send binary mail  
Sending messages, private or otherwise, to another CompuServe user is easy if you use 
WigWam. But messages are not the only thing you might want to send. There are 
circumstances where you might want to send a program file or similar. It is 
circumstances such as these where you would use the 'send binary mail' script 
command.
Firstly, you are prompted for the CompuServe ID of the person to whom you wish to send
the file.
Secondly, you are presented with the common Open file dialog so that you can select the
file to be sent.
Finally, you are prompted for a subject that is attached to the message that informs the 
recipient that binary mail has been sent to them.
The file is sent the next time you connect to CompuServe.



Status  
Displays the status of CISTERM.






